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1. How Does Run time data (Parameterization) is handled in QTP?
A) You can enter test data into the Data Table, an integrated spreadsheet with the full functionality of Excel, to manipulate data sets and create multiple test iterations, without programming, to expand test case coverage. Data can be typed in or imported from databases, spreadsheets, or text files.

2) What is keyword view and Expert view in QTP?

A) QuickTest’s Keyword Driven approach, test automation experts have full access to the underlying test and object properties, via an integrated scripting and debugging environment that is round-trip synchronized with the Keyword View.

Advanced testers can view and edit their tests in the Expert View, which reveals the underlying industry-standard VBScript that QuickTest Professional automatically generates. Any changes made in the Expert View are automatically synchronized with the Keyword View.

3) Explain about the Test Fusion Report of QTP ?

A) Once a tester has run a test, a TestFusion report displays all aspects of the test run: a high-level results overview, an expandable Tree View of the test specifying exactly where application failures occurred, the test data used, application screen shots for every step that highlight any discrepancies, and detailed explanations of each checkpoint pass and failure. By combining TestFusion reports with QuickTest Professional, you can share reports across an entire QA and development team.

4) To which environments does QTP supports ?

A) QuickTest Professional supports functional testing of all enterprise environments, including Windows, Web, ..NET, Java/J2EE, SAP, Siebel, Oracle, PeopleSoft, Visual Basic, ActiveX, mainframe terminal emulators, and Web services.

5) What is QTP ?

A) QuickTest is a graphical interface record-playback automation tool.   It is able to work with any web, java or windows client application. Quick Test enables you to test standard web objects and ActiveX controls. In addition to these environments, QuickTest Professional also enables you to test Java applets and applications and multimedia objects on Applications as well as standard Windows applications, Visual Basic 6 applications and .NET framework applications... 

6) Explain QTP Testing process ?
A) The QuickTest testing process consists of 6 main phases: 

1. Create your test plan
Prior to automating there should be a detailed description of the test including the exact steps to follow, data to be input, and all items to be verified by the test.  The verification information should include both data validations and existence or state verifications of objects in the application.

2. Recording a session on your application 

As you navigate through your application, QuickTest graphically displays each step you perform in the form of a collapsible icon-based test tree. A step is any user action that causes or makes a change in your site, such as clicking a link or image, or entering data in a form. 

1. Enhancing your test 

· Inserting checkpoints into your test lets you search for a specific value of a page, object or text string, which helps you identify whether or not your application is functioning correctly. 

NOTE:  Checkpoints can be added to a test as you record it or after the fact via the Active Screen.  It is much easier and faster to add the checkpoints during the recording process.

· Broadening the scope of your test by replacing fixed values with parameters lets you check how your application performs the same operations with multiple sets of data. 

· Adding logic and conditional statements to your test enables you to add sophisticated checks to your test. 

2. Debugging your test 

If changes were made to the script, you need to debug it to check that it operates smoothly and without interruption. 

1. Running your test on a new version of your application 
You run a test to check the behavior of your application. While running, QuickTest connects to your application and performs each step in your test. 

1. Analyzing the test results 

You examine the test results to pinpoint defects in your application. 

1. Reporting defects 

As you encounter failures in the application when analyzing test results, you will create defect reports in Defect Reporting Tool.

7) Explain the QTP Tool interface.

A) [image: image1.png]£ MercTours1
Menu bar — —File Edit View Insert Test Step Debug Tools Help

ickTest Professional

File toolbar D 5 0 & 3@ &

Test Orecon brun Wos | @ 33 1D G \

toolbar NEEEEYY

Title
bar

~Active
Screen

Debug | Brore o =
AR AT F‘\aw ok & -l
T FIND FLIGHT
Action
toolbar
retpane | [ 58 Masmcnies e iy
& Checkpoint "Welcome to Mercury” Asrival City [Acapulco
) "Search Fights” Click —
No. of Passengers : [T
"rumPassengers
Seating Preference
O biste
==
Tree View A Expert View /
Al New York
Data Table departure| B c D E G H T 2
1 [iew York ‘:]
Portland -
<[>\ Globar AAcHGRT A Actionz /- O
Status bar ] = %





 It contains the following key elements: 

Title bar, displaying the name of the currently open test 

Menu bar, displaying menus of QuickTest commands 

File toolbar, containing buttons to assist you in managing tests 
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Test toolbar, containing buttons used while creating and maintaining tests
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Debug toolbar, containing buttons used while debugging tests. 
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Note: The Debug toolbar is not displayed when you open QuickTest for the first time. You can display the Debug toolbar by choosing View > Toolbars > Debug. Note that this tutorial does not describe how to debug a test. For additional information, refer to the QuickTest Professional User's Guide. 

Action toolbar, containing buttons and a list of actions, enabling you to view the details of an individual action or the entire test flow. 
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Note: The Action toolbar is not displayed when you open QuickTest for the first time. You can display the Action toolbar by choosing View > Toolbars > Action. If you insert a reusable or external action in a test, the Action toolbar is displayed automatically. For additional information, refer to the QuickTest Professional User's Guide. 

Test pane, containing two tabs to view your test-the Tree View and the Expert View 

Test Details pane, containing the Active Screen 

Data Table, containing two tabs, Global and Action, to assist you in parameterizing your test 

Debug Viewer pane, containing three tabs to assist you in debugging your test-Watch Expressions, Variables, and Command. (The Debug Viewer pane can be opened only when a test run pauses at a breakpoint.) 

Status bar, displaying the status of the test 

8) How QTP recognizes Objects in AUT?

 A) QuickTest stores the definitions for application objects in a file called the Object Repository.  As you record your test, QuickTest will add an entry for each item you interact with.  Each Object Repository entry will be identified by a logical name (determined automatically by QuickTest), and will contain a set of properties (type, name, etc) that uniquely identify each object.  

Each line in the QuickTest script will contain a reference to the object that you interacted with, a call to the appropriate method (set, click, check) and any parameters for that method (such as the value for a call to the set method).  The references to objects in the script will all be identified by the logical name, rather than any physical, descriptive properties.

9) What are the types of Object Repositorys in QTP? 

A) QuickTest has two types of object repositories for storing object information: shared object repositories and action object repositories. You can choose which type of object repository you want to use as the default type for new tests, and you can change the default as necessary for each new test. 
The object repository per-action mode is the default setting. In this mode, QuickTest automatically creates an object repository file for each action in your test so that you can create and run tests without creating, choosing, or modifying object repository files. However, if you do modify values in an action object repository, your changes do not have any effect on other actions. Therefore, if the same test object exists in more than one action and you modify an object's property values in one action, you may need to make the same change in every action (and any test) containing the object.

10) Explain the check points in QTP?

A) . A checkpoint verifies that expected information is displayed in a Application while the test is running. You can add eight types of checkpoints to your test for standard web objects using QTP.
· A page checkpoint checks the characteristics of a Application

· A text checkpoint checks that a text string is displayed in the appropriate place on a Application. 

· An object checkpoint (Standard) checks the values of an object on a Application. 

· An image checkpoint checks the values of an image on a Application. 

· A table checkpoint checks information within a table on a Application

· An Accessiblity checkpoint checks the web page for Section 508 compliance. 

· An XML checkpoint checks the contents of individual XML data files or XML documents that are part of your Web application.

· A database checkpoint checks the contents of databases accessed by your web site

11) In how many ways we can add check points to an application using QTP.

A) We can add checkpoints while recording the application or we can add after recording is completed using Active screen (Note : To perform the second one The Active screen must be enabled while recording).

12) How does QTP identifes the object in the application
A) QTP identifies the object in the application by LogicalName and Class.

For example : 

The Edit box is identified by 

Logical Name : PSOPTIONS_BSE_TIME20

Class: WebEdit

13) If an application name is changes frequently i.e while recording it has name “Window1” and then while running its “Windows2” in this case how does QTP handles?

A) QTP handles those situations using “Regular Expressions”.

14) What is Parameterizing Tests?

A) When you test your application, you may want to check how it performs the same operations with multiple sets of data. For example, suppose you want to check how your application responds to ten separate sets of data. You could record ten separate tests, each with its own set of data. Alternatively, you can create a parameterized test that runs ten times: each time the test runs, it uses a different set of data. 

15) What is test object model in QTP ?

 A) The test object model is a large set of object types or classes that QuickTest

uses to represent the objects in your application. Each test object class has a

list of properties that can uniquely identify objects of that class and a set of

relevant methods that QuickTest can record for it.

A test object is an object that QuickTest creates in the test or component to

represent the actual object in your application. QuickTest stores information

about the object that will help it identify and check the object during the

run session.

A run-time object is the actual object in your Web site or application on

which methods are performed during the run session.

When you perform an operation on your application while recording,

QuickTest:

➤ identifies the QuickTest test object class that represents the object on which

you performed the operation and creates the appropriate test object

➤ reads the current value of the object’s properties in your application and

stores the list of properties and values with the test object

➤ chooses a unique name for the object, generally using the value of one of its

prominent properties

➤ records the operation that you performed on the object using the

appropriate QuickTest test object method

For example, suppose you click on a Find button with the following HTML

source code:

<INPUT TYPE="submit" NAME="Find" VALUE="Find">

QuickTest identifies the object that you clicked as a WebButton test object.

It creates a WebButton object with the name Find, and records the following

properties and values for the Find WebButton:

It also records that you performed a Click method on the WebButton.

QuickTest displays your step in the Keyword View like this:

QuickTest displays your step in the Expert View like this:

Browser("Mercury Interactive").Page("Mercury Interactive").

WebButton("Find").Click

16) What is Object Spy in QTP?

A) Using the Object Spy, you can view the properties of any object in an open

application. You use the Object Spy pointer to point to an object. The Object

Spy displays the selected object’s hierarchy tree and its properties and values

in the Properties tab of the Object Spy dialog box.

17. Supported Check-Points in QTP?
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17) What is the Diff between Image check-point and Bit map Check point?
A) Image checkpoints enable you to check the properties of a Web image.

You can check an area of a Web page or application as a bitmap. While

creating a test or component, you specify the area you want to check by

selecting an object. You can check an entire object or any area within an

object. QuickTest captures the specified object as a bitmap, and inserts a

checkpoint in the test or component. You can also choose to save only the

selected area of the object with your test or component in order to save disk Space

For example, suppose you have a Web site that can display a map of a city

the user specifies. The map has control keys for zooming. You can record the

new map that is displayed after one click on the control key that zooms in

the map. Using the bitmap checkpoint, you can check that the map zooms

in correctly.

You can create bitmap checkpoints for all supported testing environments

(as long as the appropriate add-ins are loaded).

Note: The results of bitmap checkpoints may be affected by factors such as

operating system, screen resolution, and color settings.

18) How many ways we can parameterize data in QTP ?

A) There are four types of parameters:

Test, action or component parameters enable you to use values passed

from your test or component, or values from other actions in your test.

Data Table parameters enable you to create a data-driven test (or action)

that runs several times using the data you supply. In each repetition, or

iteration, QuickTest uses a different value from the Data Table.

Environment variable parameters enable you to use variable values from

other sources during the run session. These may be values you supply, or

values that QuickTest generates for you based on conditions and options

you choose.

Random number parameters enable you to insert random numbers as

values in your test or component. For example, to check how your

application handles small and large ticket orders, you can have QuickTest

generate a random number and insert it in a number of tickets edit field.

20. How do u do batch testing in WR & is it possible to do in QTP, if so explain? 

   Ans: Batch Testing in WR is nothing but running the whole test set by selecting "Run Testset" from 

          the "Execution Grid".The same is possible with QTP also. If our test cases are automated then 

          by selecting "Run Testset" all the test scripts can be executed. In this process the Scripts 

          get executed one by one by keeping all the remaining scripts in "Waiting" mode.

21. if i give some thousand tests to execute in 2 days what do u do? 

     Ans : Adhoc testing is done. It Covers the least basic functionalities to verify that the system 

            is working fine.

22. what does it mean when a check point is in red color? what do u do? 

     Ans : A red color indicates  failure. Here we analyze the the cause for failure whether it is a 

            Script Issue or Envronment Issue or a Application issue.

23. what do you call the window testdirector-testlab? 

    Ans : "Execution Grid". It is place from where we Run all Manual / Automated Scripts

24. how do u create new test sets in TD

    Ans : Login to TD.

          Click on "Test Lab" tab.

          Select the Desired folder under which we need to Create the Test Set. ( Test Sets can be grouped as per module.)

          Click on "New Test Set or Ctrl+N" Icon to create a Test Set.

25. How do u do batch testing in WR & is it possible to do in QTP, if so explain? 


Ans : You can use Test Batch Runner to run several tests in succession. The results for each test are stored in their default location. 

Using Test Batch Runner, you can set up a list of tests and save the list as an .mtb file, so that you can easily run the same batch of tests again, at another time. You can also choose to include or exclude a test in your batch list from running during a batch run

26. if i give some thousand tests to execute in 2 days what do u do? 

     Ans : Adhoc testing is done. It Covers the least basic functionalities to verify that the system 

            is working fine.

27. what does it mean when a check point is in red color? what do u do? 

     Ans : A red color indicates  failure. Here we analyze the the cause for failure whether it is a 

            Script Issue or Envronment Issue or a Application issue.

28. what do you call the window testdirector-testlab? 

    Ans : "Execution Grid". It is place from where we Run all Manual / Automated Scripts

29. how do u create new test sets in TD

    Ans : Login to TD.

          Click on "Test Lab" tab.

          Select the Desired folder under which we need to Create the Test Set. ( Test Sets can be grouped as per module.)

          Click on "New Test Set or Ctrl+N" Icon to create a Test Set.

30. How to Import data from a ".xls" file to Data table during Runtime.


Ans :   Datatable.Import "...XLS file name..."



DataTable.ImportSheet(FileName, SheetSource, SheetDest)



DataTable.ImportSheet "C:\name.xls" ,1 ,"name" 

31. How to export data present in Datatable to an ".xls" file?


Ans :  DataTable.Export  "....xls file name..."

32. How to get Traceability matrix from TD?

33. How to import a test case present in ".xls" file to TD under a Test set?

34. How to attach a file to TD?

35. What do you to script when objects are removed from application?

36. Syntact for how to call one script from another? and Syntax to call one "Action" in another?

   Ans:   RunAction ActionName, [IterationMode , IterationRange , Parameters]

     Here the actions becomes reusable on making this call to any Action.

    IterationRange  String  Not always required. Indicates the rows for which action iterations

     will be performed. Valid only when the IterationMode is rngIterations. Enter the row range 

          (i.e. "1-7"), or enter rngAll to run iterations on all rows.  

  If the action called by the RunAction statement includes an ExitAction statement, the RunAction 

    statement can return the value of the ExitAction's RetVal argument. 

37. How to export QTP results to an ".xls" file?

     Ans : (a) By default it creates an "XML" file and displays the results

38. 3 differences between QTP & Winrunner?

     Ans :

            (a) QTP is object bases Scripting ( VBS) where Winrunner is TSL (C based) Scripting.  

            (b) QTP supports ".NET" application Automation not available in Winrunner

            (c) QTP has "Active Screen" support which captures the application, not available in WR.


    (d) QTP has "Data Table" to store script values , variables which WR does not have.

            (e) Using a  “point and click” capability you can easily interface with objects, their 

                definitions and create checkpoints after having recorded a script – without having 

                to navigate back to that location in your application like you have to with WinRunner. 

                This greatly speeds up script development.            

39. How to create a Runtime property for an object?

40. how to add a runtime parameter to a datasheet?

     Ans:



DataTable.LocalSheet 

                The following example uses the LocalSheet property to return the local sheet of 

                   the run-time Data Table in order to add a parameter (column) to it. 

                MyParam=DataTable.LocalSheet.AddParameter("Time", "5:45") 

41. What scripting language is QTP of?

       Ans : Vbs

42. Analyzing the Checpoint results

  Standard Checpoint :By adding standard checkpoints to your tests or components, you can 

                       compare the expected values of object properties to the object's current 

                       values during a run session. If the results do not match, the checkpoint 

                       fails.

 43.Table and DB Checkpoints:

 
By adding table checkpoints to your tests or components, you can check that a specified value 

 
 is displayed in a cell in a table on your application. By adding database checkpoints to your 


 tests or components, you can check the contents of databases accessed by your application. 


The results displayed for table and database checkpoints are similar. When you run your test or 


 component, QuickTest compares the expected results of the checkpoint to the actual results of 


 the run session. If the results do not match, the checkpoint fails. 


You can check that a specified value is displayed in a cell in a table by adding a table 


 checkpoint to your test or component. For ActiveX tables, you can also check the properties of 


 the table object. To add a table checkpoint, you use the Checkpoint Properties dialog box. 


Table checkpoints are supported for Web and ActiveX applications, as well as for a variety of 


 external add-in environments. 


You can use database checkpoints in your test or component to check databases accessed by your 


 Web site or application and to detect defects. You define a query on your database, and then 


 you create a database checkpoint that checks the results of the query. 


Database checkpoints are supported for all environments supported by QuickTest, by default, as 


 well as for a variety of external add-in environments. 


There are two ways to define a database query: 


(a) Use Microsoft Query. You can install Microsoft Query from the custom installation of Microsoft 


   Office. 

 
(b) Manually define an SQL statement.

 
The Checkpoint timeout option is available only when creating a table checkpoint. It is not 


   available when creating a database checkpoint

 44.Checking Bitmaps:


You can check an area of a Web page or application as a bitmap. While creating a test or component, you specify the area you want to check by selecting an object. You can check an entire object or any area within an object. QuickTest captures the specified object as a bitmap, and inserts a checkpoint in the test or component. You can also choose to save only the selected area of the object with your test or component in order to save disk space. 


When you run the test or component, QuickTest compares the object or selected area of the object currently displayed on the Web page or application with the bitmap stored when the test or component was recorded. If there are differences, QuickTest captures a bitmap of the actual object and displays it with the expected bitmap in the details portion of the Test Results window. By comparing the two bitmaps (expected and actual), you can identify the nature of the discrepancy. For more information on test results of a checkpoint, see Viewing Checkpoint Results. 


For example, suppose you have a Web site that can display a map of a city the user specifies. The map has control keys for zooming. You can record the new map that is displayed after one click on the control key that zooms in the map. Using the bitmap checkpoint, you can check that the map zooms in correctly. 


You can create bitmap checkpoints for all supported testing environments (as long as the appropriate add-ins are loaded). 


Note: The results of bitmap checkpoints may be affected by factors such as operating system, screen resolution, and color settings.

45.Text/Text Area Checkpoint :


In the Text/Text Area Checkpoint Properties dialog box, you can specify the text to be checked as well as which text is displayed before and after the checked text. These configuration options are particularly helpful when the text string you want to check appears several times or when it could change in a predictable way during run sessions. 


Note: In Windows-based environments, if there is more than one line of text selected, the Checkpoint Summary pane displays [complex value] instead of the selected text string. You can then click Configure to view and manipulate the actual selected text for the checkpoint. 


QuickTest automatically displays the Checked Text in red and the text before and after the Checked Text in blue. For text area checkpoints, only the text string captured from the defined area is displayed (Text Before and Text After are not displayed). 


To designate parts of the captured string as Checked Text and other parts as Text Before and Text After, click the Configure button. The Configure Text Selection dialog box opens

Checking XML :


XML (Extensible Markup Language) is a meta-markup language for text documents that is endorsed as a standard by the W3C. XML makes the complex data structures portable between different computer environments/operating systems and programming languages, facilitating the sharing of data. 


XML files contain text with simple tags that describe the data within an XML document. These tags describe the data content, but not the presentation of the data. Applications that display an XML document or file use either Cascading Style Sheets (CSS) or XSL Formatting Objects (XSL-FO) to present the data. 


You can verify the data content of XML files by inserting XML checkpoints. A few common uses of XML checkpoints are described below: 


An XML file can be a static data file that is accessed in order to retrieve commonly used data for which a quick response time is needed—for example, country names, zip codes, or area codes. Although this data can change over time, it is normally quite static. You can use an XML file checkpoint to validate that the data has not changed from one application release to another.


An XML file can consist of elements with attributes and values (character data). There is a parent and child relationship between the elements, and elements can have attributes associated with them. If any part of this structure (including data) changes, your application's ability to process the XML file may be affected. Using an XML checkpoint, you can check the content of an element to make sure that its tags, attributes, and values have not changed.


XML files are often an intermediary that retrieves dynamically changing data from one system. The data is then accessed by another system using Document Type Definitions (DTD), enabling the accessing system to read and display the information in the file. You can use an XML checkpoint and parameterize the captured data values in order to check an XML document or file whose data changes in a predictable way.


XML documents and files often need a well-defined structure in order to be portable across platforms and development systems. One way to accomplish this is by developing an XML schema, which describes the structure of the XML elements and data types. You can use schema validation to check that each item of content in an XML file adheres to the schema description of the element in which the content is to be placed.

46 . Object Repositories types, Which & when to use?


Deciding Which Object Repository Mode to Choose 


 To choose the default object repository mode and the appropriate object repository mode for each test, you need to understand the differences between the two modes. 


In general, the object repository per-action mode is easiest to use when you are creating simple record and run tests, especially under the following conditions: 


You have only one, or very few, tests that correspond to a given application, interface, or set of objects.


You do not expect to frequently modify test object properties.


You generally create single-action tests.


Conversely, the shared object repository mode is generally the preferred mode when: 


You have several tests that test elements of the same application, interface, or set of objects.


You expect the object properties in your application to change from time to time and/or you regularly need to update or modify test object properties.


You often work with multi-action tests and regularly use the Insert Copy of Action and Insert Call to Action options.

47. Can we Script any test case with out having Object repository? or Using Object Repository is a must?


Ans: No. U can script with out Object repository by knowing the Window Handlers, spying and recognizing the

               objects logical names and properties available.

48. How to execute a WinRunner Script in QTP?


Ans : (a) TSLTest.RunTest TestPath, TestSet [, Parameters ] --> Used in QTP 6.0 used for backward compatibility



Parameters : The test set within Quality Center, in which test runs are stored. Note that this argument is relevant only when working with a test in a Quality Center project. When the test is not saved in Quality Center, this parameter is ignored.

               e.g : TSLTest.RunTest "D:\test1", "" 

      (b)



TSLTest.RunTestEx TestPath, RunMinimized, CloseApp [, Parameters ] 


TSLTest.RunTestEx "C:\WinRunner\Tests\basic_flight", TRUE, FALSE, "MyValue" 


CloseApp : Indicates whether to close the WinRunner application when the WinRunner test run ends. 


Parameters : Up to 15 WinRunner function argument

49. How to handle Run-time errors?


(a) On Error Resume Next : causes execution to continue with the statement immediately following the statement that caused the run-time error, or with the statement immediately following the most recent call out of the procedure containing the On Error Resume Next statement. This allows execution to continue despite a run-time error. You can then build the error-handling routine inline within the procedure.


Using "Err" object msgbox  "Error no: " & "  " & Err.Number & "      " & Err.description & "  " & Err.Source & Err.HelpContext 

50. How to change the run-time value of a property for an object?


Ans : SetTOProperty changes the property values used to identify an object during the test run.



Only properties that are included in the test object description can be set

51. How to retrieve the property of an object?


Ans :  using "GetRoProperty".

52. How to open any application during Scripting?


Ans : SystemUtil , object used to open and close applications and processes during a run session.


(a) A SystemUtil.Run statement is automatically added to your test when you run an application from the Start menu or the Run dialog box while recording a test


     E.g :
SystemUtil.Run "Notepad.exe"




SystemUtil.CloseDescendentProcesses ( Closes all the processes opened by QTP )

53. Types of properties that Quick Test learns while recording?


Ans : (a) Mandatory (b) Assistive .  



In addition to recording the mandatory and assistive properties specified in the Object Identification dialog box, QuickTest can also record a backup ordinal identifier for each test object. The ordinal identifier assigns the object a numerical value that indicates its order relative to other objects with an otherwise identical description (objects that have the same values for all properties specified in the mandatory and assistive property lists). This ordered value enables QuickTest to create a unique description when the mandatory and assistive properties are not sufficient to do so. 

54. What is the extension of script and object repository files?


Ans :  Object Repository : .tsr   ,  Script :  .mts, Excel : Default.xls

55. How to supress warnings from the "Test results page"?


Ans : From the Test results Viewer "Tools > Filters > Warnings"...must be "Unchecked".

29. When we try to use test run option "Run from Step", the browser is not launching automatically why?


Ans : This is default behaviour.

56. Does QTP is "Unicode" compatible?


Ans : QTP 6.5 is not but QTP 8.0 is expected to be Unicode compatabile by end of December 2004.

57. How to "Turn Off" QTP results after running a Script?


Ans : Goto "Tools > Options > Run Tab" and Deselect "View results when run session ends". But this supresses only the result window, but a og will be created and can viewed manulaly which cannot be restricted from getting created.

58. How to get "FontSize" of a "WebEdit"?

59. Is there anyway to automatically update the Datasource name in Database Checkpoints object when we  migrate tests to a new release?

60. How to verify the Cursor focus of a certain field?


Ans : Use "focus" property of "GetRoProperty" method"

61. Any limitation to XML Checkpoints?


Ans : Mercury has determined that 1.4MB is the maximum size of a XML file that QTP 6.5 can handle

62. How to make arguments optional in a function?


Ans : this is not possible as default VBS doesn't support this. Instead you can pass a blank scring and have a default value if arguments r not required.

63. How to covert a String to an integer?


Ans : CInt()---> a conversion function available.

64. Inserting a Call to Action is not Importing all columns in Datatable of globalsheet. Why?


Ans : Inserting a call to action will only Import the columns of the Action called

